ArrangePak-3D

User’s Manual
Manipulating Arrangements of Planes in Three Dimensions

Ray Dufresne,
Stephen Wismath

University of Lethbridge,
Lethbridge, Alberta, Canada

Funded in part by:

Natural Sciences and Engineering Research Council of Canada
Copyright ©2004 Stephen Wismath. All rights reserved.
This document does not convey a warranty, express or implied, of merchantability or fitness for a particular purpose.

version 1.0x

License: The ArrangePak-3D source code was written by Ray Dufresne under the supervision of Dr. Stephen Wismath at the University of Lethbridge in 2003-2004. ArrangePak-3D is freely available and distributed under the terms of the GNU General Public Licence. However, it relies on a proprietary library of algorithms and data types which requires a separate licence if you wish to build the program from source code. In this case, you will need a copy of LEDA\(^1\), version 4.3.1 or greater installed on your system.

Acknowledgments: The software was tested by Elspeth Nickle whose advice and suggestions are gratefully acknowledged.

\(^1\)Library of Efficient Data Types and Algorithms, www.algorithmic-solutions.com
# Contents

1 Introduction .............................................. 1
   1.1 Installing ArrangePak-3D ............................... 2
   1.2 Terms and Conventions ................................. 2
      1.2.1 Plane Arrangements ............................... 3
      1.2.2 Interactive Modes ................................. 3

2 Using ArrangePak-3D ...................................... 7
   2.1 The Panel Menu ....................................... 8
   2.1.1 Plane Operations .................................... 9
   2.1.2 File Operations ..................................... 12
   2.2 ArrangePak-3D Options ................................ 15
   2.3 Online Help .......................................... 15
   2.4 Terminating an ArrangePak-3D Session ............... 15
   2.5 Context Menu Operations ............................. 15

3 The GraphWin Interface .................................. 17

4 Troubleshooting ArrangePak-3D .......................... 19
   4.1 ArrangePak-3D Configuration Errors ................. 19
      4.1.1 Window Size ....................................... 19
      4.1.2 Help Directory Path Errors ....................... 19
      4.1.3 File Path Errors .................................. 19
   4.2 File I/O Errors ...................................... 20
   4.3 Open Bugs .......................................... 20

Reading List .............................................. 23
List of Figures

2.1 The basic user interface ........................................ 7
2.2 Random arrangement at startup ................................. 8
2.3 ArrangePak-3D menu bar ....................................... 8
2.4 The Planes pull-down menu .................................... 9
2.5 Delete planes prompt in message zone, plane-interactive mode 10
2.6 Drag planes prompt in message zone, plane-interactive mode . 10
2.7 Unit-vector coordinates during drag operation ............... 11
2.8 Interactive transformation of a plane .......................... 11
2.9 Wireframe view of all planes .................................. 12
2.10 A sample ArrangePak-3D data file ............................. 13
2.11 The File pull-down menu ..................................... 13
2.12 An ArrangePak-3D node file .................................. 14

3.1 Random layout of graph data in the GraphWin interface ... 17
3.2 Orthogonal graph layout in the GraphWin interface ........ 18

4.1 Valid arrangement generates graph error ....................... 21
Chapter 1

Introduction

ArrangePak-3D was developed as an aid to investigate properties of the arrangement graphs induced by planes in three dimensions. This software provides a graphical environment for the user, greatly simplifying the process of visualizing and working with planes in $R^3$ and producing their resulting arrangement graphs.

ArrangePak-3D relies on two fundamental concepts from three-dimensional geometry:

- The intersection of any two non-coincident, non-parallel planes results in a line.
- The intersection of three such planes comprises a point.

Given an arrangement $P$ of planes in general position, ArrangePak-3D calculates all $\binom{n}{2}$ intersection lines and $\binom{n}{3}$ points, and constructs the resulting undirected arrangement graph $AG(P)$ defined as follows. Each point where three planes intersect corresponds to a vertex in the graph. Two vertices are adjacent if their corresponding intersection points exist along the same line formed by two intersecting planes and if there are no other intersection points between them in $R^3$.

Constructively, the line segments of finite length between adjacent points in $R^3$ comprise the set of edges for the undirected graph. There is an important distinction between the given arrangement of planes and the resulting abstract arrangement graph; however it is common practice to identify the two concepts and mix the terminology.

The user initially creates and manipulates a collection of planes, using a virtual “viewport” through which the layout of the planes is inspected and altered. For any arrangement of planes, the user may also generate the corresponding 3-D arrangement graph. Additional tools are available to analyze the graph.

Whereas arrangement graphs of lines in two dimensions have been well studied, the corresponding arrangement graphs of planes in three dimensions
and their properties are almost unknown. Software for manipulating arrangements of lines in two dimensions (ArrangePak) has also been developed at the University of Lethbridge and is available at:

www.cs.uleth.ca/~wismath/packages/.

1.1 Installing ArrangePak-3D

A binary executable version of ArrangePak-3D, compiled for the UNIX/Solaris operating system running on Sun SPARC workstations, is available from the website and provides the simplest means of running the software.

The most recent version of the source code (C++) is also available at:

www.cs.uleth.ca/~wismath/packages/.

ArrangePak-3D is freely available under the terms of the GNU General Public Licence. However, it relies on a proprietary library of algorithms and data types which requires a separate licence. If you wish to build the program from source code, you will need a copy of LEDA\(^1\), version 4.3.1 or greater installed on your system. ArrangePak-3D might compile and run with earlier versions of LEDA, but it was written and tested using version 4.3.1.\(^2\) You will also need the GCC compiler. ArrangePak-3D was developed using GCC version 2.95.3. Lastly, since ArrangePak-3D is a graphical application, it must run in an X window environment. A mouse is required.

The source code is distributed as a UNIX tar file, which can be unpacked to any directory. Edit the file named ‘Makefile’ to reflect the correct path to your LEDA installation, and also adjust other flags in the makefile (e.g. compiler optimization options). From a command line prompt in the same directory where you unpacked the files, type ‘make’ (without the single quotes). Providing that the compiler can find the necessary LEDA library files, the makefile script should produce a single executable file named ‘a3d’.

If you are installing only the binary executable, simply unpack the UNIX tar archive file and verify that the file ‘a3d’ has executable permissions.

1.2 Terms and Conventions

ArrangePak-3D uses a right-handed coordinate system to describe the perpendicular orientation of each axis with respect to the remaining two. From the user’s perspective, the x-axis is the horizontal axis, the y-axis is the vertical axis, and the z-axis is through the display. The z-axis is positive moving toward the user, and negative moving away from the user, through the back of the computer display.

\(^1\)Library of Efficient Data Types and Algorithms, www.algorithmic-solutions.com

\(^2\)Distribution of ArrangePak-3D does not include distribution of LEDA, nor does it imply licence rights to LEDA.
1.2. Terms and Conventions

We primarily use unit-vector notation to describe planes in $\mathbb{R}^3$. A normalized direction vector is given, having its tail at the origin and its head at the coordinates given by a point at $(x, y, z)$. The resulting plane in $\mathbb{R}^3$ is perpendicular to the direction vector, and contains the point at $(x, y, z)$.

The viewport is a circle in the $Z = 0$ plane. The center of the viewport is at $(0, 0, 0)$, the origin of the coordinate system.

1.2.1 Plane Arrangements

An arrangement of planes is a set of $n$ planes in three-dimensional space. To simplify definitions we avoid degenerate cases such as 4 planes intersecting at a common point. Planes in $\mathbb{R}^3$ that do not intersect the viewport cannot be visualized, and are therefore outside the universe of planes considered by ArrangePak-3D. Likewise, planes that are coincident to the viewport are not legal.

A valid arrangement of planes for ArrangePak-3D has six properties:

1. Each plane in the set must intersect the viewport face.

2. The intersection of the viewport with each plane must be a line. No plane in the arrangement will be coincident with the plane described by the viewport.

3. No plane may be coincident with any other plane in the set. For any two planes $P_1$ and $P_2$, $P_1 \neq P_2$.

4. From the preceding, it follows that the intersection of any three planes may not be a line in $\mathbb{R}^3$.

5. No two planes may be exactly parallel.

6. The distance between any two vertices (the intersection of three planes) may not be 0. For any two vertices $v_1$ and $v_2$, $v_1 \neq v_2$.

1.2.2 Interactive Modes

There are three interactive modes described in this manual.

- In menu-interactive mode the user may view, but not manipulate, the planes in the viewport. The user can access all menu options in menu-interactive mode.

- In plane-interactive mode the user may modify the planes, either deleting or manipulating individual planes. The menu bar is disabled in plane-interactive mode.
Introduction

- In **graph-interactive mode** the user will be working in a separate interface window. The main *ArrangePak-3D* interface is disabled in *graph-interactive mode*. 
This page intentionally left blank.
Introduction
Chapter 2

Using ArrangePak-3D

When ArrangePak-3D is invoked, it constructs an application window in the center of the display. This is the basic user interface, shown in Figure 2.1. The gray circle is the viewport that bounds the user's view of the planes.

The vertical and horizontal lines form the crosshair, intersecting at the origin in the center of the viewport. Note the mouse coordinates, shown in the lower left corner of the application window.

![Figure 2.1: The basic user interface](image)

By default, an arrangement of three planes is generated when ArrangePak-3D begins. The planes are randomly generated and will differ each time the program is invoked. Figure 2.2 is an example of a random arrangement.

The black lines in the viewport are the lines of intersection between the
random planes and the viewport. The view of these lines is bounded by the viewport, although the planes continue beyond it.

2.1 The Panel Menu

Across the top panel of the application window is a **menu bar**, with menu items for **File**, **Planes**, **Options**, and **Help**, as well as a **Quit** item. Underneath the menu bar is a **slider bar** for selecting the number of planes in an arrangement. Figure 2.3 shows the ArrangePak-3D menu bar and slider bar. The upper left corner of the main window, immediately underneath the slider bar, is the **message zone**. It will display operational status messages to the user. Most of the time, the message zone will be blank.

![ArrangePak-3D menu bar](image)

Figure 2.3: ArrangePak-3D menu bar

Each menu item is accessed with a single click of the left-mouse button,
or by using the Alt-key sequence corresponding to the underscore letter associated with the menu item. For example, from the main user interface, pressing Alt-p on the keyboard will open the Planes pull-down menu.

2.1.1 Plane Operations

Operations on the arrangement of planes are listed under the Planes menu, shown in Figure 2.4.

![Figure 2.4: The Planes pull-down menu](image)

**Generate Random Planes** will discard the current arrangement and generate a new one. Select the number of planes for the new arrangement using the slider bar, before choosing this menu item. The maximum number of planes allowed in an arrangement is twenty.

**Add random plane** adds a single random plane to the current arrangement.

**Add default plane** adds a single plane to the current arrangement. The default plane is horizontal and contains the origin point.

**Delete planes** permits the user to eliminate any or all planes from the arrangement. When this item is selected, ArrangePak-3D switches to plane-interactive mode. The normal cursor will change to a hand icon with a pointing finger, and the message zone will display the message shown in Figure 2.5.

To delete planes one at a time, position the mouse cursor in the viewport, close to the plane you wish to discard, and single-click the left mouse button. It is not necessary to touch the plane with the cursor. The plane (represented by a line in the viewport) nearest the cursor will automatically be located and removed from the arrangement. You may continue deleting planes until there is only one plane left. When you are finished, you may return to menu-interactive mode by single-clicking the right mouse button.

**Drag planes** also causes ArrangePak-3D to switch to plane-interactive mode. Again, the normal cursor will change to a hand icon with a pointing
Using ArrangePak-3D

Figure 2.5: Delete planes prompt in message zone, *plane-interactive* mode

Figure 2.6: Drag planes prompt in message zone, *plane-interactive* mode

At this point, you may select a plane to manipulate, or cancel the operation and return to *menu-interactive* mode by single-clicking the right mouse button.

To select a plane, position the mouse cursor in the viewport close to the plane you wish to modify, and single-click the left mouse button. It is not necessary to touch the plane with the cursor. The plane nearest the cursor will automatically be located and selected.

Once a plane has been selected, the status message in the *message zone* will instruct you to drag the selected plane, or right-click the mouse to end the operation. At the same time, the unit-vector coordinates that describe the plane will appear in the upper left corner of the window, as shown in Figure 2.7. The numerical label corresponding to the selected plane is also displayed in upper left corner whenever a plane is selected in this manner.

The representation of planes in the viewport will change during a *drag* or transform operation. The intersection lines for all planes in the viewport will be ‘grayed out’ except for the selected plane, which will appear as a three-dimensional wire-frame. The line of intersection between the selected plane and the viewport will be black. A blue line represents a leading ‘edge’ of the plane, an arbitrary distance along the positive z-axis, and a gray line represents a receding ‘edge’ of the plane, at some arbitrary distance along the
Figure 2.7: Unit-vector coordinates during drag operation

negative z-axis. Side edges, in gray, help to describe the orientation of the plane by connecting the front and back edges. An example of this is given in Figure 2.8.

Figure 2.8: Interactive transformation of a plane

Five colored circles appear along the edges of the plane. These handles indicate that the plane can be transformed in three-dimensional space by rotating it around the $x$, $y$, and $z$ axes. To manipulate the plane, position the mouse cursor close to a handle, hold down the left mouse button and drag the mouse. As the plane is transformed, the coordinates for the unit-vector change to match the new result.

When you are done manipulating the plane, release the left mouse button, and click the right mouse button once. This action overwrites the new plane
configuration to the arrangement, and resets the viewport to show lines of intersection for all planes. The cursor will change to a hand icon, and you may select another plane to transform with a single click of the left mouse button, or return to \textit{menu-interactive} mode with a single click of the right mouse button.

Note that the entire menu panel is grayed out, and therefore inaccessible, in \textit{plane-interactive} mode.

\textbf{Show all planes} will generate ‘pseudo-3D’ wireframes for all planes in the viewport. This provides a visual demonstration of how all planes are oriented, relative to each other, at any time. Figure 2.9 includes a view of the \textit{message zone} when this menu option is selected.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{ arrangpak.png}
\caption{Wireframe view of all planes}
\end{figure}

\subsection{File Operations}

All \texttt{ArrangePak-3D} input and output files are ASCII text files. Each line of text is a single record entry consisting of four fields which define a plane in $R^3$ using point-normal notation:

- The first field, an integer, enumerates the record entries, beginning at the number 1. This integer corresponds to the plane number seen in the upper left portion of the display whenever a plane is selected for transformation using the \textit{drag} menu option.

- The second field is a point in $R^3$ contained by the plane.
2.1. The Panel Menu

- The third field for all entries is the number 3, signifying that the plane is in three-dimensional space.
- The final field is a triple: the \( x \), \( y \), and \( z \) coordinates in \( \mathbb{R}^3 \) for the unit-vector perpendicular to the plane.

A sample \texttt{ArrangePak-3D} file is shown in 2.10. Note the four-line file header, describing the contents of the file.

```
# Generated by ArrangePak-3D
# Arrangement of Planes in 3D space
# DO NOT EDIT THIS FILE!
# Planes are defined by Point-Normal notation
#--------------------------------------------------------
# Point                      Normal       Vector
# 1 (10.5686, 38.63108, -78.4562) 3 0.719001 -0.55787 0.414511
# 2 (56.0873, 22.26845, -89.9189) 3 0.652355 0.106051 0.750288
# 3 (26.3294, 19.34398, 84.71762) 3 -0.772447 0.626335 0.105024
# 4 (-118.08, -115.774, 101.9781) 3 -0.674014 0.564797 -0.47614
# 5 (4.14808, -151.567, -70.0648) 3 -0.558461 -0.288304 0.777819
# 6 (-106.63, -97.4691, -86.3328) 3 0.193358 0.84453 0.499382
# 7 (30.6828, -153.578, 139.8354) 3 0.105702 0.741829 -0.662206
# 8 (-138.25, -93.1548, -76.3026) 3 -0.525557 0.450771 0.721522
```

Figure 2.10: A sample \texttt{ArrangePak-3D} data file

The **File** menu, Figure 2.11, permits you to save an arrangement of planes to an output file, load an arrangement from a file, and generate graphs which may be analyzed using other tools.

![File pull-down menu](image)

**Load** will open a dialog box and prompt you to enter the name of a file containing a list of \texttt{ArrangePak-3D} planes. If a valid filename is supplied, the current arrangement is discarded and plane data from the file is imported into \texttt{ArrangePak-3D}. The result will be displayed as a new arrangement in the viewport.

**Save** will export the current arrangement to an \texttt{ArrangePak-3D} data file using the format shown previously in 2.10. The user is prompted to supply a filename for the output file. If the file cannot be written, a message box will display the error. Otherwise, a status message will be displayed in the **message zone** indicating that the file was successfully exported.
Using ArrangePak-3D

**Generate graph** constructs an undirected graph \( G \) for which the set of vertices \( v \) is all points of intersection in \( \mathbb{R}^3 \) formed by any three planes in the arrangement. For a valid arrangement of \( n \) planes, the number of vertices in graph \( G \) will total \( n \times C \)

Given any two vertices \( u, v \) in \( G \), an undirected edge will exist between \( u \) and \( v \) if:

- \( u \) and \( v \) lie on the same line of intersection between two planes

- \( u \) and \( v \) are adjacent

The set of edges \( e \) for graph \( G \) is comprised of all such edges.

If the arrangement of planes is not valid, an error will occur and the graph will not be constructed. If the graph can be generated, it will be displayed in a new window.

Whenever a graph is generated, the menu bar in the ArrangePak-3D interface is disabled. Closing the graph window restores menu functionality to the ArrangePak-3D interface.

**Export to GLuskap file** exports the undirected graph \( G \) to a GLuskap-formatted text file. GLuskap is a software tool for editing and displaying drawings of graphs in three dimensions and was also developed at the University of Lethbridge. More information can be found at the website: www.cs.uleth.ca/~wismath/packages/ When this menu item is selected, the user will be prompted for a filename to which the graph information will be exported. By default, the suffix ‘.mg’ will be appended to the filename provided by the user.

**Generate Node List** exports the set of vertices \( v \) for graph \( G \) to a text file. The suffix ‘nodes’ will be appended to the filename provided by the user. Each record in the file consists of the enumeration label for the vertex, the three planes that intersect to form the vertex, and the cartesian coordinates where the vertex is located. In the example shown in Figure 2.12, the second node is labeled ‘Node #1’; is formed by the intersection of planes 1, 2 and 4; and is located in \( \mathbb{R}^3 \) at \((-21.7377, -37.5882, -8.7148)\).

<table>
<thead>
<tr>
<th>#</th>
<th>NODE LIST FOR GRAPH - GENERATED by ArrangePak-3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1.2.3 ( -70.3235, -86.8068, 19.2483 )</td>
</tr>
<tr>
<td>1</td>
<td>1.2.4 ( -21.7377, -37.5882, -8.7148 )</td>
</tr>
<tr>
<td>2</td>
<td>1.2.5 ( -24.5602, -40.4675, 12.2244 )</td>
</tr>
<tr>
<td>3</td>
<td>1.2.6 ( -49.7766, -65.9922, -6.152 )</td>
</tr>
<tr>
<td>4</td>
<td>1.3.4 ( -6.6499, -21.2628, -12.375 )</td>
</tr>
<tr>
<td>5</td>
<td>1.3.5 ( 79.2126, 67.1218, 151.876 )</td>
</tr>
<tr>
<td>6</td>
<td>1.3.6 ( -122.07, -141.106, -207.88 )</td>
</tr>
</tbody>
</table>

Figure 2.12: An ArrangePak-3D node file

**Exit** terminates the ArrangePak-3D session.
2.2 ArrangePak-3D Options

There are a number of user-configurable options in ArrangePak-3D. They are accessible from the Options pull-down menu.

Crosshair permits the user to configure the crosshair, which defines x,y coordinates \((0,0)\) at the center of the viewport.

Cursor provides several mouse cursors from which the user may choose. During certain operations in plane-interactive and graph-interactive modes, the cursor will switch to a predefined shape which cannot be changed by the user.

Toggle Cursor Coordinates toggles the visibility of the cursor coordinates, displayed in the lower left of the application window.

Set file path allows the user to modify the filepath for all file operations during the current ArrangePak-3D session. The default filepath for an ArrangePak-3D session is the filepath from which the executable command was invoked.

2.3 Online Help

ArrangePak-3D includes an online help file and contact information.

Online help opens an online help file in a separate window. The user may move forward through the file by choosing the Next-> button at the bottom of the online help window. Choosing the Done button will close the online help window.

The installation software for ArrangePak-3D includes a directory called Help which contains several text files. By default, this directory is installed as a subdirectory of the pathname containing the program code. In order for ArrangePak-3D to locate the online help files while it is running, the Help directory must be installed as a subdirectory of the pathname from which ArrangePak-3D is invoked.

About ArrangePak-3D displays general information about the program and the software licence. Choosing Continue will close the window.

2.4 Terminating an ArrangePak-3D Session

The user may terminate an ArrangePak-3D session by selecting Quit from the main menu. This will immediately end the session. Changes to the default configurable options, such as the filepath, are not saved.

2.5 Context Menu Operations

While in menu-interactive mode, certain menu selections are available via a pop-up, or context, menu.
With the mouse anywhere in the main window area, the user may click on
the right mouse button, causing a pop-up menu to appear with the following
selections:

- **Load** – imports an arrangement of planes from a file specified by the
  user. Same action as **File->Load** on the menu bar.

- **Save** – saves the current arrangement of planes to a file specified by
  the user. Same action as **File->Save** on the menu bar.

- **Graph** – constructs an undirected graph based on the current arrange-
  ment of planes. Graph will appear in a separate window. Same action
  as **File->Generate graph** on the menu bar.

- **Add random** – adds a single random plane to the arrangement.

- **Add default** – adds a single plane to the current arrangement. The
  default plane is horizontal and contains the origin point.

- **Delete** – switches to **plane-interactive** mode, permitting the user to
  eliminate any or all planes from the arrangement, one at a time. Same
  action as **Planes->Delete planes** on the menu bar.

- **Drag** – switches to **plane-interactive** mode. Allows user to manipu-
  late planes, one at a time, by dragging and rotating. The numeri-
  cal label corresponding to the selected plane is displayed in upper left
  corner whenever a plane is selected in this manner. Same action as
  **Planes->Drag planes** on the menu bar.

- **Help** – opens an online help file in a separate window. Same action as
  **Help->Online help** on the menu bar.

- **Refresh** – forces a refresh of the viewport interface. Certain user
  actions may sometimes cause portions of the plane arrangement or
  viewport to be overwritten by other video information. In such a case,
  part or all of the viewport may be temporarily blanked out. Resizing
  the viewport window, or choosing certain pull-down menu selections
  from the main menu bar sometimes cause this.

  In order to refresh the viewport, it is necessary to select this item from
  the pop-up menu. There is no menu item on the main menu bar to
  refresh the viewport.

- **Quit** – Choosing this item will immediately terminate **ArrangePak-3D**.
Chapter 3

The GraphWin Interface

In addition to analysing and manipulating arrangements of planes, the user may analyse the properties of graphs formed by the arrangements. *ArrangePak-3D* uses a powerful interactive graphics interface for displaying and manipulating graph node and edge data.

The interface, called a GraphWin (a combination of graph and window), is part of LEDA, the Library of Efficient Data Types and Algorithms. GraphWin’s standard menu includes layout and animation tools, graph modifiers, embedding algorithms, and tests.

Figure 3.1 shows an example of graph data generated by *ArrangePak-3D* and exported to a GraphWin interface.

![GraphWin Interface Diagram](image)

Figure 3.1: Random layout of graph data in the GraphWin interface

By default, the node and edge layout is initially random. The GraphWin
The GraphWin Interface

interface provides more elaborate layout algorithms and tools. For example, in Figure 3.2, the graph in Figure 3.1 is displayed with an orthogonal layout specified.

Figure 3.2: Orthogonal graph layout in the GraphWin interface

A complete description of how to use the LEDA GraphWin interface is beyond the scope of this manual. For complete information on how to use GraphWin, refer to the LEDA User's Manual or the LEDA Guide.
Chapter 4

Troubleshooting ArrangePak-3D

4.1 ArrangePak-3D Configuration Errors

4.1.1 Window Size

When ArrangePak-3D is invoked, it creates an application window based on the current display resolution. The user may resize the window by placing the mouse cursor at the edge of the window, holding down the left mouse button, and dragging the mouse to move the window edge inward or outward. The window may be resized diagonally by dragging any corner of the window.

The viewport size will always attempt to fit within the new window size, but may have problems with some window aspect ratios. When such a problem occurs, a “Bad window size!” error message will be displayed in the ArrangePak-3D application window. To resolve the error, resize the window, and click “OK” on the error message box.

Maintaining a reasonable window size, with an aspect ratio that is approximately 1:1 will avoid a window size error.

4.1.2 Help Directory Path Errors

In addition to online help via the main menu or context menu, ArrangePak-3D provides help during file operations by clicking on the “Help” button in the filepath window.

In each case, the ArrangePak-3D Help files must exist in a ‘Help’ directory located at the pathname location from where the ArrangePak-3D executable file is called.

If ArrangePak-3D cannot find the ‘Help’ directory, it will generate a ‘file not found’ error message whenever online help is requested by the user.

4.1.3 File Path Errors

The default path for all file I/O operations (load/save) is the path from which ArrangePak-3D is invoked. The user may change the default filepath through
the ArrangePak-3D options menu. If a non-existent pathname is specified, a “Bad pathname” error message is displayed in a message window.

If the specified pathname exists, but the user does not have read and write privileges, a corresponding error message is also displayed in a message window.

4.2 File I/O Errors

If the user attempts to load a file for which the user does not have read permissions, or a file that does not exist in the current filepath, ArrangePak-3D will return the error:

“Error opening input file. Check path, file name, and read permissions.”

If ArrangePak-3D finds the file, the program will analyze the input data before importing the file.

If the file is not an ArrangePak-3D input file, is incorrectly formatted, or the data describes a degenerate arrangement, ArrangePak-3D will return the error:

“File is corrupt or contains disallowed planes. Operation cancelled.”

Refer to the introductory chapter for a review of the properties that define a valid arrangement.

After attempting to import a corrupt or invalid file, clear the error message display window to return to the viewport, which will contain no planes. Reset the slider bar and generate a new arrangement, or try importing a valid ArrangePak-3D data file.

4.3 Open Bugs

When ArrangePak-3D calculates the line of intersection between two planes, the algorithm engine must identify the line by two distinct points. ArrangePak-3D then identifies its graph nodes as the point of intersection between such a line and any other planes in the arrangement. Infrequently, LEDA will identify a line of intersection by two identical points. While it is true that both (identical) points exist on that line, it is impossible for ArrangePak-3D to determine the actual line from that information, and therefore impossible for ArrangePak-3D to determine the graph nodes corresponding to the arrangement of planes.

An example of such an arrangement is shown in Figure 4.1.

LEDA calculates the line of intersection for planes 1 and 2, and returns a line through coordinates ( 50, 44.314, 0 ) and ( 50, 44.314, 5.625e-07 ). Plane 3 cuts through this line creating a point at ( 50, 44.314, 7.03125e-07 ).

Given planes 1, 2, and 4, the first two planes intersect at a line containing points ( 50, 44.314, 0 ) and ( 50, 44.314, 5.625e-07 ). Plane 4 intersects the line at ( 52.5, 44.314, -0.5 ). Up to this point, things are working well.
4.3. Open Bugs

Figure 4.1: Valid arrangement generates graph error

LEDA then calculates the line of intersection between planes 1 and 3, and returns two points identifying the line. Those points are (50, 44.314, 0) and (50, 44.314, 0). When LEDA attempts to calculate a point of intersection between the given line and plane 4, it returns an error status. In order for LEDA to find the point of intersection between a line and a plane, it is essential that the line be identified by two disjoint points.

From this we can see that some valid arrangements will nevertheless yield errors when calculating the output graph as a consequence of this LEDA bug. When this error occurs, we suggest choosing slightly different input data to identify at least one of the planes in the arrangement.

For arrangements such as the previous example, although the input data is valid, ArrangePak-3D will terminate with the following error if the user attempts to generate a graph:

WARNING! Node list has 3 nodes in it. The node list is incomplete, probably due to parallel or coincident planes.
Troubleshooting ArrangePak-3D
Reading List


<http://www.algorithmic-solutions.info/leda_guide/index.html>


Index

ArrangePak-3D, 1
  compiling, iv, 2
  configuring, 15
  error messages, 19
  executable, 2
  exit session, 15
  installing, 2
  licence, iv, 2
  source code, 2

arrangement graph, 1

coordinate system, 2

degree, 1
error messages, 19

GLuskap, 14
graph
  generating, 14
GraphWin interface, 17

help, 15

interactive modes, 3

LEDA, iv, 2
  GraphWin, 17

menu
  context, 15
  file operations, 12
  menu bar, 8
  plane operations, 9
message zone, 8

node list, 14

plane arrangement, 3
  defined, 3
  deleting, 9

properties, 3
show all, 12
transforming, 9

slider bar, 8

troubleshooting, 19

vertex, 1
viewport, 1, 3, 7
  crosshair, 7
  refresh, 16